


Creating
Multi-Table
Queries

In the Beginning Course, all of the queries that you created were
based on a single table. Now that you have created relationships
between the different tables in your database, you can create
queries that involve more than one table. Multi-table queries are an 
important part of any relational database management system.

You are going to create some multi-table queries.

1. Open the Queries database file.

2. Before you create the queries, you are going to look at
the Relationships window.

On the Tools menu, choose Relationships.

Notice the relationships that have been created. Any 
of these linked tables can be used easily in a
multi-table query.

3. Close the Relationships window.

Queries with
One-to-One
Relationships

Just as one-to-one relationships are not as common as one-to-many
relationships, queries involving one-to-one relationships are not as
common as other types of queries. 

You are going to create a query that lists students with their
guardians. All of the queries that you will create in this lesson are
Select Queries. 

1. On the Database window, select the Queries tab.

2. Click the New button.

The New Query dialog box appears. You are going
to use Design view to create the query.

3. Verify that Design View is selected and then click OK.

The Show Table window appears, with the Query
Design window behind it.
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4. To create this query, the Students and Guardians tables 
must both be displayed.

On the Show Table dialog box, use CTRL/click to
select both the Students and Guardians tables. If
another table is selected, such as Attendance,
deselect it.

5. On the Show Table dialog box, click the Add button 
and then click the Close button.

In the top pane of the Query Design window, the
Field Lists for the selected tables appear. Notice that
Access indicates that the tables are related with a
join line between the appropriate fields.

6. Your query will display information from both tables.

In the Students Field List, double-click the StudentID
field.

Access places the field in the
first column of the design
grid. Notice that the Table
row indicates the table in
which the field is located.

Note: If the Ta ble row is not
dis played on your grid, choose Ta ble Names on the
View menu.

7. In the same way, place the LastName and FirstName
fields from the Students Field List to the query
design grid.

8. Remember, you can also select the appropriate field
from the Field row. You are going to use this technique
to place the Contact1 field in the design grid.

Click an insertion point in the Field row of the
fourth column and then tap F4 to display the list
box.
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Notice how Access displays the available fields.
Each field is preceded by its
table name and a period
(alphabetically by table name).
When only one table is
displayed in the top pane,
Access does not bother using
the table names.

9. In the list box, choose Guardians.Contact1. (It may
be necessary first to point to the right border of
the Column Selection bar
and drag right so that you
may see the field names.)

Only the field name is
placed in the Field row of
the query grid. The table
name is placed in the Table row.

10. From the Guardians Field List, place the
Relationship1, C1Street, C1City, C1State, C1Zip, and
C1PhoneH fields in the query design grid.

11. In the Students Field List, double-click the Grade
field to place it at the end of the query design grid.

12. You are going to sort the records by the student names.

In the LastName column, click the Sort drop-down
list box and choose Ascending.

13. In the FirstName column, click the Sort drop-down
list box and choose Ascending.

14. Before you run the query, it is a good idea to save it.

On the File menu, choose Save.

15. Use the Save As dialog box to name the query
Students/Guardians and then click OK.

16. On the Query menu, choose Run.

Tip: You can also click the Run but ton
on the toolbar.

Notice the results of the query.
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Since the tables are linked, Access is able to display
information from both tables in the same query. In
addition, since this is a one-to-one relationship, each 
record in the Students table is matched with exactly
one record in the Guardians table.

17. Close the query datasheet window.

In the Database window, notice the new
Students/Guardians query object.

Queries with
One-to-Many
Relationships

A more common type of Select Query uses tables with a
one-to-many relationship. You are going to create a query to
display the student grades. While creating the query, you will also
use selection criteria to display specified records. (For more about
selection criteria, refer to the Beginning Course.)

1. The Queries tab should be selected.

2. Click the New button on the Database window.

3. In the New Query dialog box, verify that Design
View is selected and then click OK.

4. Use the Show Table dialog box to display the
Students and the StudentGrades table. Close the
dialog box when finished.

In the top pane, Access displays the Field Lists along 
with the appropriate join line, indicating that these
tables are related.

5. In the Students Field List, double-click the StudentID, 
LastName, and FirstName fields.
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The fields appear in the query design grid.

6. You are going to use all of the fields from the
StudentGrades table. There is a quick way of doing this.

At the top of the StudentGrades Field
List, double-click the asterisk (*).

StudentGrades.* appears in the fourth
column of the query grid. Although
the individual fields do not appear in the grid, the
results of the query will display all fields in the
StudentGrades table.

7. Use the Sort row to sort the query results by
LastName and then FirstName.

8. Save the query with the name Grades.

9. On the Query Design toolbar, click the Run
button.

Notice the results of the query.

Since this is a one-to-many relationship, the selected
data from the Students table are repeated for each
corresponding record in the StudentGrades table.

10. Double-click the right borders of the first and
fourth column headers to resize the columns.

Notice that the StudentID field appears twice. The
first appearance is the field you placed from the
Students table. The second appearance is the one you 
placed from the StudentGrades table. Because the
field names are identical, Access distinguishes
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between the two occurrences by preceding the field
name with its table name.

Now that you have created the query, you are going to modify its
appearance by sorting the records by semester.  

1. On the View menu, choose Design View.

2. In order to sort by the Semester field, it must appear in
the query design grid. When you placed all fields from
the StudentGrades table, none of its field names
appeared in the grid. You must place the Semester field 
again to be able to use it for sorting the query results.

Place the Semester field from the StudentGrades
table into the query design grid.

3. In the Sort row of the Semester column, choose a
sort order of Ascending.

Note: When mul ti ple sort cri te ria are set, Ac cess
sorts fields from left to right as they appear in the
query design grid. In this case, Ac cess will sort by
LastName, FirstName, and then Se mes ter.

4. If you were to run the query now, the Semester field
would appear twice — once as a result of the
StudentGrades.* column, and once as a result of the
Semester column. You will hide the second case.

In the Semester column, deselect
the Show check box 
to prevent Access from 
displaying the field.

5. You are going to set criteria so that only students in
grade 11 or 12 are displayed. To do so, you must place
the Grade field in the design grid.

In the Students Field List, double-click the Grade
field to place it in the design grid.

6. Deselect the Show box of the Grade column so that
the field does not appear in the query result.

7. In the Criteria row of the column, type: 11 or 12

Note: You could also en ter this cri te ria with out the
OR log i cal operator. Just keep in mind that cri te ria
that ap pear in the same row are com bined with the
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AND op er a tor. Cri te ria that ap pear in dif fer ent rows 
are com bined with the OR operator.

8. On the Query Design toolbar, click the Run button.

Notice the results of the query. Only students in the
11th and 12th grades are displayed.

9. Save the query and then close the datasheet.

Notes When using Select Queries, keep in mind that you can
usually edit the results of the query. For example, if you use
a query to display the grades for a particular student, you
can change the grades by simply editing the appropriate
field in the query results. These changes are applied to the
table in which the field is located.

If a relationship does not exist between two tables, you can
create a temporary one in the Query Design window. If two
tables that contain fields with matching data are displayed,
you can simply drag the matching field from one table to the
other. A temporary join line will be created only for the
active query.

In the same way, you can create select queries using more
than two related tables. In the Review Exercise, you will be
asked to create a query that uses the Student, StudentGrades,
and Courses tables.
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Summarizing
Data

When you display every grade for each student, it can be difficult
to get an overall picture of how a student is doing. Fortunately, you 
can design queries that group and summarize data, such as overall
averages for students, or total orders for clients.

You are going to use some of the data summary commands
available in queries.

1. With the Queries tab of the Database window
selected, click New.

2. In the New Query dialog box, verify that Design
View is selected and then click OK.

3. In the Show Table dialog box, display the Students
and the StudentGrades tables and then click Close.

4. From the Students Field List, place the StudentID 
field into the design grid.

5. From the StudentGrades Field List, place the
CourseGrade field into the design grid.

If you were to run the query at this time, Access
would display all grades for each student. Instead of 
doing this, you are going to use the Totals
commands to provide different summaries of course 
grades for each student.

Counting
Totals

For data stored in a single table, it is relatively easy to determine
counts of specific items. For example, to determine how many
students are in the 9th grade, you can either use a filter or a query
to display only these records. This can become more tedious when
multiple tables are involved or if you are looking for totals of more
than one item at a time.

You are going to use the Totals feature to count the number of
courses each student has taken.

1. The Query Design window should be active.

2. On the View menu, select Totals. (If Totals has a
check mark next to it already, tap the ESC key to
close the menu.)
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In the design grid, notice the Total row.

Unlike the other rows of the design grid, something
must always be displayed in the Total row for each
field. By default, Access sets it to Group By,
indicating that the query results will be grouped by
the indicated field. Although this is appropriate for
the StudentID field (the grades should be grouped
according to the StudentID), it is not appropriate for
the CourseGrade field.

3. Click an insertion point in the Total row of the
CourseGrade column and then tap F4 to display the
drop-down list box.

Notice the other options available.
Although you will not use all of
these options in this lesson, they
work in similar ways.

4. Choose Count.

You are asking the query to provide a count of the
number of CourseGrades, grouped by StudentID.
Since each CourseGrade corresponds to one course,
this is the same as counting the number of courses
each student has taken.

5. Save the query and name it StudentTotals.

6. Run the query.

Notice the query results.
Instead of listing each Course-
Grade, the query counts the
number of CourseGrades for each 
student. Access automatically
changes the column heading to
CountOf CourseGrade. If a
student does not have any
course grades listed, the
corresponding StudentID does
not appear in the query results.
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Note: You can not mod ify re cords that are the re sult
of a query that used the sum mary op tions.

Currently, this query is of limited use. You are going to modify it
so that the name of the students are displayed along with their
StudentID.

1. On the Query Datasheet toolbar, click the View
button to switch to Design View.

2. From the Students Field List, add the LastName and
FirstName fields to the design grid.

Although the Total row indicates that the query
results will be grouped by these fields as well, in
reality they will have no actual effect on the query.
This is because you are already grouping by the
StudentID field, which is a unique field. Query
results cannot be grouped any further.

3. So that the student names will appear next to the
StudentID field, you are going to move the
CourseGrade column to the right of the design grid.

At the top of the CourseGrade column, point to the
column selection bar so that the pointer changes to 
a downward-pointing arrow.

Click to select the column.

The entire CourseGrade column 
is selected.

4. Point to the column selection bar and drag the
selected column to the right of the FirstName
column.

5. Release when the dark
vertical line appears to the
right of the FirstName field.

CourseGrade is now the last column in the design grid.

6. Save the changes to the query.

7. Run the query.

Notice the results of the query. The names that
correspond to the StudentID field were added to the
results, making it easier to see the number of courses 
each student took.
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Calculating
Averages

The average grade for each student can be calculated quickly using
the Total row. You are going to modify the current query to display 
each student's average grade.

1. Switch to Design View.

2. Click an insertion point in the Total row of the
CourseGrade column.

3. Use F4 to display the drop-down list box and then
select Avg (you will need to scroll the list box).

4. Run the query.

5. If necessary, double-click the right edge of the last
field header so that you can see all the data in the
last column.

Notice the
results of 
the query.

Instead of displaying the number of course grades
for each student, the query displays the average of
the course grades. At the top of the last column,
notice that Access indicates that this is the
AvgOfCourseGrade.

Note: You will for mat the re sults of que ries in the
next les son.
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To hide the totals, you can simply remove the Total row from the
query design grid.

1. Switch to Design View.

2. Instead of using the View menu, you will use the
toolbar button.

On the Query Design toolbar, click the Totals 
button.

Notice that the Total row is removed from the design 
grid.

3. Run the query.

As would be expected, the query results display
each grade for each course that every student has
taken. It is difficult to get an overall picture of how
students are doing.

4. Switch back to Design View.

5. On the Query Design toolbar, click the Totals
button.

The Total row appears again. Notice that Access
remembers the most recently used value in the Total
row of each column.

Note: The items avail able in the To tal drop-down list 
box are also called ag gre gate func tions. You will be
work ing more with these later in the course.

Displaying
Top Values

When you are trying to get an overview of the results of a query, it
can be convenient to display only the top values for a certain field,
such as course average, salary, or date of hire. You can use the Top
Values drop-down list box to specify the number of values to be
included in the query results.

You are going to modify the current query so that only the students 
with the top five averages are displayed.

1. The StudentTotals query should be open in Design
view.

2. On the Query Design toolbar, click 
the Top Values drop-down list box.
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Notice the options available. By default, Access
displays All records selected by the query. You can
also have Access display a percentage of the values
or an absolute number of values.

3. On the list, choose 5.

Only the top five values of the records selected by
the query will be displayed.

Tip: You can also type a par tic u lar value di rectly
into the Top Val ues box.

4. The field for which the top values are to be calculated
is always the leftmost (first) field in the query design
grid. Rather than move the CourseGrade field from its
current position, you will insert a new CourseGrade
field that will not be displayed.

Drag the CourseGrade field from the StudentGrades
Field List to the very left column of the query grid
(the one currently showing StudentID).

The CourseGrade field is inserted at the left of the
grid.

5. In the Total row, choose Avg.

6. Choose a sort order of Descending.

This will cause the students to be listed from highest 
grade average to lowest.

7. Deselect the Show check box.

The design grid should look like the following:

8. Save the changes and run the query.

Notice the results of the query.
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Keep in mind that these are not all of the records "
only the records of the students with the five highest 
grade averages.

9. Close the datasheet window.

Grouping
Fields

So far, you have been grouping the results of the queries by the
StudentID field. In order to get a better understanding of how the
Group By option works, you are going to group the results by other
fields.

1. Open the StudentTotals query in Design View.

2. You are going to redesign the query.

On the Edit menu, choose Clear Grid.

3. You are going to see which grade has the highest
average.

In the Students Field List, double-click the Grade
field to place it in the grid.

4. Choose a sort order of Ascending.

5. In the StudentGrades Field List, double-click the
CourseGrade field to place it in the second column
of the design grid.

6. In the Total field of the CourseGrade column, choose 
Avg.

7. You need to reset the Top Values drop-down list box.

On the Query Design toolbar, click 
the Top Values drop-down list box 
and choose All.

8. Run the query.

Notice the results of the query. The course averages
have been calculated and grouped by the grades.
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Within each grade, you are interested in how individual
homerooms are doing. You can display these results with a
grouping by the HomeRoom field.

1. Switch to Design View.

2. Drag the HomeRoom field from the Students Field
List to the second column of the design grid.

The CourseGrade field moves to the third column and 
the HomeRoom field is placed in the grid. By default,
Access has set the Total row to Group By. The grade
averages will by grouped by Grade and then
HomeRoom.

3. Run the query.

Notice the results of the query.

4. Close the query datasheet. There is no need to save 
changes.

At times, it might be necessary to “group by” and total the same
field in order to get the desired effect. You are going to create a
query to display the attendance results for each student.

1. This query will be based only on the Attendance table.
There is a quick way of doing this.

On the Database window, select the Tables tab.

2. Click the Attendance table object to select it.

3. On the Insert menu, choose Query.

4. On the New Query dialog box, verify that Design
View is selected and then click OK.

The Query Design window appears with the
Attendance Field List already displayed. Notice the
Attendance table contains only three fields. As you
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might recall, the Attendance field contains one of two 
values — Absent or Late.

5. Place the StudentID field and then the Attendance
field into the design grid.

6. On the Query Design toolbar, click the Totals
button (if necessary) to display the Total row.

By default, Group By appears in each column. You
might be tempted to change the value in the
Attendance column to Count in order to add up the
attendance for each student. Although this is
incorrect, you will do it in order to better
understand what happens.

7. In the Attendance column, change the Total row to
Count.

8. Save the query as AttendanceCount.

9. Run the query.

Notice the results of the
query. Instead of counting the 
number of times each student 
was late and absent, the
query simply counted the
number of times each
individual Attendance value
(i.e., Absent or Late) appears
for each StudentID.

In order to get the desired
results, you must first group the query results by the 
Attendance field — allowing the query to display the
individual values of the field — and then do a count
on the same field.

10. You are going to fix the query.

Switch to Design View.

11. In the second column of the query design grid,
change the Total row to Group By.

12. In the Attendance Field List, double-click the
Attendance field to add it to the third column.

Although there are two instances of the Attendance
field in the query design grid, they will serve
different purposes.
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13. Change the Total row of the third column to Count.

Access will group the records in the Attendance table
first by StudentID and then by the values of the
Attendance field. It will then count the occurrences of 
the each grouped Attendance value.

14. Save the changes to the query.

The design grid should look like the following:

15. Run the query.

Notice the results. For each StudentID, a separate
row of the query datasheet is used to list the number 
of absences and latenesses.

16. Close the query datasheet.

Review
Exercise

To review the concepts presented in this lesson, you are going to
create a query to display all of the courses that each student has
taken, including the semester in which the course was taken. In
addition, you will use the Total row to summarize the number of
credits each student earned per semester.

1. Use any technique to open a Query Design window
for a new query.

2. Display the Field Lists for the Students,
StudentGrades, and Courses tables.
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3. Add the following fields to the query design grid:
StudentID, LastName, FirstName, CourseID, Semester,
CourseName, Credits.

4. Sort the query results in ascending order by
LastName, then FirstName, then Semester, then
CourseName. 

To sort in this order, the fields must appear in this
order in the design grid (although they don't all
need to be adjacent). If they are not in this order, you 
will need to rearrange them.

5. Save the query as StudentCoursesTaken.

6. Run the query.

The results should look like the following:

7. You are going to modify the query so that total credits
for each semester are displayed.

Switch to Design View.

8. Delete the CourseID and CourseName columns.

9. Use the Total row to Sum the Credits field for each
student.

10. Use the Save As command to save the query with
the name CreditsEarned.

11. Run the query.
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Notice the query results.

12. Modify the query so that the sum of all credits
earned is displayed. This final query should look
like the following:

End of Lesson 5
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